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Work Flow for the project 
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Step 1:  Open EDS Program 

To start, open the Data 7 EDS program.     

Step 2:  Design Values 

Set your desired stitch length and density using the EDS “Design Preferences” from the 
“Design” menu. 

Values are measured in “points” each point is 0.1mm and so 30 points = 3.00 mm  

In this example each running stitch will be placed 3mm apart from each other and column 
stitches will be placed 4.2mm apart   

 

The Stitch Length - size of each stitch  

The Column Density -distance between 
each column stitch side 

“Column Width” parameter increases 
the width of your digitised columns by 
that percentage.   

“Fill Stitch length” stitch size when column fill is selected 
(see below) 

“Fill Type A & B” two predefined fill settings for 
column fills – while digitising you can set customised 
values with  the ”Insert Fill” button 

 

Step 3:  Open an image to use as a template   

For this project, you will need to download the image 
‘flower.jpg’ and save it somewhere you can find easily 
on your computer. Then load it via the “Load Image” 
option from the “Image” menu. 
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Step 4:  Start Digitising 

Start a new digitising session by selecting “Start Session” from the 
“Digitise” menu or “Left Click”  the Digitise button 

 

 

Step 5:  Choose thread colour 

The “Color” dialog box should now appear automatically 

Choose a starting colour you wish to digitize with. 

 

 

 

Step 6:  Mark centre of design- “Origin”  

Mark the Origin or centre of your design using the left mouse button.   

This can be anywhere in the digitising window  

 

 

 

 

 

 

Step 7:  Running stitch digitising mode 

By default when you start digitising the mode is set to running stitch. We can toggle between 
running stitch and column stitch at any time by either clicking the “Running Stitch” and “Column 
stitch” buttons below or by pressing the “Enter” key. 

 

Step 8:  Jump Stitch 

Now we must jump to the start point of our design 

Make one small stitch to the right of the origin with a “left click” then  choose the “Needle up” function, 

(you will notice that the status bar will indicated whether the needle is in the up or down position) place 
a single stitch- “left click” at the destination which will be the top left corner of the outer border  
then choose the “Needle down” function.  

The jump stitch will show as a dashed line. 
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Step 9:  Digitising the border  

We are going to use statin stitch – straight column stitch – for the 
border. Firstly we need to lay down a simple underlay stitch using 
straight running stitch 

(For more detailed instructions on running stitch and curved running 

stitch see “How to digitise a straight and curved running stitch” 
tutorial.) 

Using the left mouse button simply click on the top left corner of the 
design, then the top right corner, bottom left, bottom right and finally 
top left again 

You can see the running stitches I’ve laid down, be sure to end as close 
as possible to the first click. This is where our columns will start and end  

 

 

 

Step 10:  Column digitising mode 

We start our column stitches by switching to column stitch mode by pressing the “Enter” key. 

We will be using “left click” to place the points to form our columns.  

The sequence of left mouse 
buttons, for a straight column  

This is a zigzag formation.  
Each time you reach the forth 
column stitch the column is 
filled with the stitches 

 

Columns can be continued simply by following the same zigzag 
sequence again and again 

(For more detailed instructions see “How to digitise straight and curved 
column or satin stitch” tutorial ) 

So now finish the border by left clicking the inside and then the 
outside of each corner until you are back at the start. 

Once you have finished your column digitising, simply press the 
“Enter” key or click the “Running Stitch” button to drop back to a 
running stitch.  

  

http://www.data7consultancy.com/Downloads/column%20stitch%20help.pdf
http://www.data7consultancy.com/Downloads/column%20stitch%20help.pdf
http://www.data7consultancy.com/Downloads/column%20stitch%20help.pdf
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Step 11:  Tie off Stitch 

“Left Click” the “Tie off”   button to ensure that your design does not unravel itself when you trim the 
threads of jump stitches or when you change thread colour. A tie off stitch is simply a small star shape of 4 

small stitches. 

 

Step 12:  Jump Stitch and change thread colour 

Now we must jump to the start point of our next section to be 
digitized and change the thread colour. 

Choose “Needle up” function, choose the “change colour” 
function and select a new colour and OK, then “left click” at the 
destination which will be centre of our flower - then choose the 
“Needle down” function followed again by a tie off stitch.  

The jump stitch will show as a dashed line. 

 

Step 13:  End Session 

It is probably good practice to save our design on a regular base, so we need to exit the digitizing mode to do 
this. Simply click the “End Digitising Session” button  

 

Step 14:  Saved as condensed 

All Data 7 EDS digitised designs are first saved in, what is called a “Quick 
Condensed Format” where only the outline of a design is recorded or 
digitised. Condensed formats make it easy to edit and resize designs 
without the issue of final stitch size and density changing. (More about 
this in later tutorials.) 

So select “Save Condensed As” from the “File” menu or “Save QCD As” 
from the “Save” button, and give your design a name. 

 

 

Step 15:  Continue with design 

We now need to go back into our design and continue to digitise it. 

So select “Start Session” from the “Digitise” menu or “Left Click” the “Digitise” button, this time we are not asked 
for a colour chose as it will continue from where we left off. 
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Step 16:  Curved running stitch underlay 

We now need to create an arc using the curve running stitch.  
Firstly place a running stitch (left mouse button) just to the left of the 
last stitch  
Now simply use the right mouse button to place curve stitches clock 
wise at 12, 3, 6 and 10 o’clock which will create a curved running 
stitch. There must be at least 3 stitches to create a curve running 
stitch.  

Now go back round again the other way, so “left click” to the left of 
the last stich then “right click” at 6, 3 12 and 9 o’clock.  

 

 

 

Step 17:  Curved column digitising mode 

We now need to create a curve column using the column stitch with left and right 
mouse buttons. 

First the theory (you can find more details in the “How to digitise straight and 
curved column or satin stitch” tutorial)  

To create a curved column we start with two column stitches (left mouse button - 
but then we place to curved column stitches (right mouse button) in the middle of 
the curve still in a zigzag formation (indicated by the black arrows) and then end 
with two column stitches (left mouse button) which creates a curved column as 
shown and highlighted in blue. 

As with the straight columns you can continue to create further column and 
curved columns before switching back to running stitch mode. 

 

So to put it into practice – 

We start our column stitches by switching to 
column stitch mode by pressing the “Enter” key 

“Left click” at the tip of the centre arch, “left click” 
again just above, then complete the curve with 
“right click’s” as shown in diagram, but making 
sure the last two are “left click’s” 

  

http://www.data7consultancy.com/Downloads/column%20stitch%20help.pdf
http://www.data7consultancy.com/Downloads/column%20stitch%20help.pdf
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Switch back to running stitch mode by pressing the “Enter” key and finish section with: 

a) “Tie off” button 
b) “Needle up” button 
c) “Change colour” button – choose new colour  

 
d) “Left click” on start of first petal 

 
e) “Needle down” button  
f) “Tie off” button 
g) “End Digitising Session” button  

 
h) “Save QCD” from the “Save” button   

 
i)  “Digitise” button 
j) “Zoom in” 

This time we are going to use straight running stitch 
zigzagging across the arches to form the under laying stitches, 
working with “left clicks” first clock wise along the arch and 
then back again.  

 

 

 

 

 

Now change to “column stitch” (“Enter”) and cover the arch with a “curved column stitch” by “left click” at the tip 
of the arch, “left click” again just above, then complete the 
curve with “right click’s” as shown in diagram, making sure the 
last two are “left clicks” and then switch back to “running 
stitch” (“Enter”)  

 

 

 

 

 

Now repeat the tie off, and jump stitch routine and complete the other petals and the 
stalk, at the end of the stalk we will not need a jump stitch but it would be a good idea to 
do steps f to j before moving on. 
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Step 18:  Complex fill digitising mode 

We now need to move on to the two leaves, we will use a satin stitch fill  

Firstly we need to lay down the underlay stitch using straight running stitch as we did for each 
of the petals, finishing near the tip of the leaf. 

Still in running stitch - Initiate your fill by selecting “Insert fill A button”  

Using “Insert Fill buttons A or B” automatically places the fill density and stitch length 
predefined in your “design preferences”.  

The third button “Insert Fill” allows you to use different 
values at this point. You can then enter a tailored fill 
density and stitch length.  

 (To access or check the predefined fill values before 
entering the digitising mode, see “Step 2 - Design 

Values” or look at the “How to digitise a complex fill” 
tutorial) 

Next we need to tell EDS the angle of stitches in the fill.  
We do this with the first two run stitches using “left 
click” (1) and “left click” (2)  

Now we need to define the 1st side of the fill by marking 
it with column stitches using “right click’s” (3, 4, 5, 6) 
and ending with a running stitch “left click”. (7) that 
marks the end of side 1. 

 

 

 

Now we repeat the process to define side 2 of our fill using column stitches  
“right click” (8, 9 &10) ending with the final running stitch “left click” (11) which 
defines side 2. Once the last point is entered the complex fill is calculated and 
created. 

Then repeat the process for the second leaf. 

 

  

http://www.data7consultancy.com/Downloads/Complex%20Fill%20Lesson.pdf
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Step 19:  Use special stitches 

Now we are going to create the last border using a blanket stitch which we can find in the 
“special stitch” mode, simply click the “Insert special stitch” button. 

(You can find more information in the “How to digitise using special stitches” tutorial) 

 

You will now be shown a gallery of built in special stitches to choose from. 

Choose the fifth design “5.qss”by clicking on the button and click on “OK”.  

This returns you to the canvas and sets the stitch ready for use.  

 

 

Now place stitches as with normal running stitch using the “left click” for 
first and last stitch and the “right click” to place the curved points working 
in an anti-clockwise direction so the blanket stich points inwards. 

When finished choose the “special stitch off” button  

We are now back in normal running stitch so finish off by “Left Click “  the  
“tie off” button 

Now choose “End Digitising Session” button and do a final “Save 
Condensed” from the “Save” button 

 

 

 

 

 

Step 20:  Saved as Expanded 

Embroidery machines cannot use condensed designs as they need to know every stitch 
so we have to convert it to an expanded format first, before we can export it to your 
embroidery machines native format. 

So either choose the “Save Expanded As” from the “File” menu or use the “Save QEP 
As” from the “Save” button.  

Once saved as expanded, the condensed design is unloaded and is replaced with the 
expanded version you just saved. The condensed version still remains as condensed a 
file which is saved, on your drive to use later if needed for editing etc…  
(See the “Editing condensed designs tutorial”) 

  

http://www.data7consultancy.com/Downloads/digitising%20with%20special%20stitch%20help.pdf
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Step 21:  Export to machine code 

Having created our “Quick Expanded Design” we are now ready to export it to our 
embroidery machine   

(Data 7 EDS exports to about 20 listed in the “How to export your digitised design to a 
machine format for embroidering” tutorial. See this tutorial for more details on exporting 
designs)  

Choose “Save Design As” from the “File” menu 

You will now see the “Export Design” dialog screen appear 

This allows you to choose what embroidery machine format to export to, where to save it and what name to call it.  

 

So in the “Designs Location” browser 
choose where you want to save the 
design  

Use the “Format filter”, to choose 
which format you want to export to.  

Enter the file name in the “File Name” 
box that you want to call your design. 

And then click the “Process” or “Save” 
button in the top left corner 

Once done simply click the “Exit” 
button shown above to return to the 
Data 7 EDS system. 

 

  

http://www.data7consultancy.com/Downloads/exporting%20digitised%20designs%20to%20machine%20format%20help.pdf
http://www.data7consultancy.com/Downloads/exporting%20digitised%20designs%20to%20machine%20format%20help.pdf
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Appendix 

Undo 

At present there is no actual undo button, but if you make a mistake or something unexpected happens use 
the “delete stitch” button immediately followed by the “redraw screen” button. 

 

Zooming 

To zoom in to our image to start digitising use the “Zoom” and “Pan” functions.  

To use the free “Zoom” function “left click” once at the top 
left of the area you want to zoom in to and then “left click” 

again at the bottom right. This will result in zooming in to the 
design making it much easier to digitise. 

 

 

The second button “Zoom *2” zooms in, doubling each time, and the third button “Zoom out 
*2”zooms back out. 

The next two buttons will restore the design to 100% scale “Actual size” and “Fit 
Window” will fit the whole design on the screen 

Use the “Pan” button when you are zoomed in, a large box will appear, move the mouse 
and then “left click” to reposition the design on the screen. 

Loading Digitised designs 

To load a previously digitised design to continue working on it or 
to convert it to expanded format.  

We can do this in two ways;  

Either choose “Open Quick Condensed” from the “file” 
menu, or use the “Open Condensed File” button. 

Then simply choose your design from the “Design gallery, by 
clicking on the button and clicking OK. Double clicking on the 
button will also load the design without the need to click OK.  

Or choose the design wanted from the list of last saved designs if 
it is there 

 


